
Computerised Switching 

Introduction 
The Switcher program generates switching moves for a model railroad based on the 

information supplied about freight cars, loads carried and locations visited. The moves can 

be printed out in switchlist format or in a simplified car card/waybill style. 

 

 

  



The individual columns can be resized, or in some cases hidden, and printed out in 

landscape or portrait format. There is also a wide format where pickup and set down details 

are shown in separate columns: 

 

A Quick Start 
To generate a quick switchlist based on the sample data provided, select Dataset 3 from the 

Options screen then click the New Sequence button. 

To see how the sample data is set up, click Edit Data and use the tabbed screens to view the 

car types, cars, loads, locations and locos in the sample dataset. 

To start entering data of your own, select Dataset 1 or Dataset 2 from the Options screen, 

then click Edit Data and used the tabbed screens as described below. 



Main Screen 

 

The main screen shows the most recently generated switchlist underneath a set of options. 

Initially, of course, this screen will be blank. 

All options are also available via the menu or, in some cases, via function keys. 

The first thing to do is to set up some data. 

 
The edit screen is accessed via the Edit Data button, via the Edit menu or by pressing F2. It 

allows you to specify cars, car types, loads, locations and optional locos using a series of tabs. 

There are limits to the lengths of the data but subject to this, entries can be as descriptive or 

as concise as you like. 

On each tabbed display, use the + button to insert a new record, the button with the bin icon 

to delete a record, and the arrow buttons, mouse or keyboard to navigate up and down. 

Linked screens enable you to allocate cars to loads, and loads to locations. (Note that there is 

no direct link between cars and locations – they are linked to each other via the loads). 



Edit Screen – Car Types and Cars 

 

The first tab on the edit screen allows you to enter car types. 

Having entered the car types, switch to the second tab or click Edit Cars… to enter individual 

road names and numbers for each car type. 

 



 

Edit Screen - Loads 

 

The third tab on the edit screen allows you to enter loads and, optionally, their offscene 

source and destination. These offscene locations are notional, representing a nominal 

supplier and customer, and will typically be represented by a storage or fiddle yard. 

From this tab the Assign Cars… button brings up another screen to assign individual cars to 

each load. Use the left and right arrow buttons at the top to scroll through the loads, and the 

Assign and Remove buttons to allocate or deallocate cars as required. 



 

You can assign the same car to more than one load. 

All cars for a given load will be ordered randomly before the sequence starts, and if there is 

more than one trip or spot for that load the cars will be cycled through in the order 

generated. 

Edit Screen – Locations 

 



The fourth tab allows you to enter the spot locations. Typically, a location will equate to one 

of the industries on your layout or, in the case of a large industry, perhaps a part of the 

industry dealing with a particular type of car or load. 

Optionally, a direction (1 or 0) for each location can be specified, for use with the “Split 

directions” option on the main screen. This specifies the direction of travel of the train 

relative to the location and, if used, each location is visited on alternate (same direction) 

trips only. 

The number of spots at each location can be entered. If no figure is entered, one spot is 

assumed. 

Each location can be assigned a sequence number or spot order, and any such locations will 

be listed on the switchlist in that order for a given trip. Any locations not assigned a spot 

order will be listed after the sequenced ones in alphabetical order. 

If “Reverse direction each trip” on the Options screen is selected, on alternate trips locations 

will be listed in reverse spot order or reverse alphabetical order as appropriate. 

From the Locations tab, click Assign Loads… to allocate loads to each location. Use the 

Assign and Remove buttons to allocate or deallocate loads from the list on the left as 

required. 

 

Each load can have a frequency and direction (not to be confused with the location’s 

direction, above) assigned to it. 

Frequency is the number of times each load will be spotted at a particular location over the 

series of trips in the switching sequence. Loads cannot be allocated for delivery on specific 

days, but you can think of the frequency as days or trips, so if all loads at all locations have a 

frequency of 1, they will all be spotted once during the switching sequence. But by changing 

the frequency, you can stretch the sequence out to cover a number of days or trips. 

Fractions are catered for to introduce variety to the number of times a load is spotted. For 

example, 0.5 means there will be a 50-50 chance the load will be dealt with, 0.8 will give the 



load an 80 percent chance of being delivered, and 2.5 will mean there will be either two or 

three deliveries in the sequence. If a frequency is not specified, 1 will be assumed. 

Direction specifies the direction of the load as seen from the perspective of the industry. 

Letter o (not number zero) means outbound, i.e. the car is spotted empty and returns loaded, 

and letter i (not number one) means inbound, i.e. the car is spotted loaded and returns from 

its spot location empty. If a direction is not specified the load will be assumed to be inbound. 

As an alternative, x can be entered for the load direction. This means the car remains in an 

indeterminate state, e.g. in the case of a tank car delivering oil to more than one location and 

being considered neither full nor empty at any particular time. 

Direction can be entered in upper or lower case. 

The same load can be assigned to more than one location. 

Paired Locations 
The direction column can also be used to ‘force’ a car from one location to another, where a 

load needs to be transferred between them. If the sequence number of the second location is 

entered into this column, the car will be spotted empty at the first location, then ‘loaded’ and 

moved to the second location on a subsequent trip. This type of operation won’t work for a 

chain of more than two spots. 

Edit Screen - Locos (optional) 

 

The fifth tab allows you to specify optional locos. Each trip, a loco will be chosen at random 

from the list. 

If you enter a loco list but choose not to use it, you can suppress the loco column on the 

switchlist (see below). 



Main Screen 

 
Once you are happy with your data, click the New Sequence button on the main screen to 

generate the switching moves. Each click of the New Sequence button will produce a new list 

of moves based on the current operating and display options. The moves will be spread over 

one or more trips depending on the number of loads and the frequency options chosen for 

each load/location combination. 

The columns widths of the switchlist can be changed to suit the data, and will be saved on 

exit. Thus, if you have given your cars, loads or locations very short descriptions, you can 

narrow the columns right down, and vice versa. 

 
Clicking the Options button, selecting Options from the File menu or pressing F11 will show 

the Options screen: 

 

Hiding Unwanted Columns 
In addition to adjusting any of the column widths, the columns showing locos, ‘From’ and 

‘To’ locations, and car type can all be hidden if desired, in which case they will not be shown 

or printed. 



Continuity 
Some cars may be left spotted at the end of a sequence and, if the checkbox entitled “Clear all 

locations at end of each sequence” is left unticked, they will start the next sequence from the 

same spots.  

If the ‘Show occupied locations at start of sequence’ box is checked, cars left spotted at the 

end of the previous sequence will be listed on a cream background at the top of the next 

sequence before Trip 1. 

Off-spots 
If the “Use off-spots” box is checked, the switch list will randomly bring a car onto the layout 

before its destination spot has been vacated, and you will have to find a temporary spot for it. 

In this case the spot location will read “Off-spot” and the car at the final destination will 

show on the next line as being held. The move will be completed next trip. 

Direction Options 
There are three options for travel direction. 

Same direction each trip: typically for single track layouts with one staging yard which the 

trains originate from and return to. 

Reverse direction each trip: for use where all locations are visited both ways, e.g. on a 

layout with a fiddle yard at both ends. 

Split directions: where some locations are spotted from one direction and others from the 

opposite direction, e.g. for industries on opposing spurs, or either side of a double track. This 

option uses the direction indicators on the Locations edit screen. If you find cars are being 

spotted in the wrong direction, simply flip the indicators round. 

The direction indicators are ignored for the first two direction options. 

Datasets 
You can switch between up to three different datasets by clicking the appropriate option 

button. 

The dataset currently in use will be shown in the title bar of the main screen. 

All of the options specific to each dataset, including column widths set manually, will be 

saved on exit. The current switchlist will be saved too and re-loaded next time unless you 

switch datasets in the meantime. 

The datasets have a .db3 suffix. They are stored in your documents folder in a sub-folder 

called Switcher20. 

Data in any of the datasets, including the sample data in Dataset 3, can be deleted by using 

the Clear All Data button. 



Intensity 
Intensity of operations can be set to high, medium or low. With high, all spots are made as 

early as possible. With medium and low, the spots are more spread out in random fashion 

over more trips. 

Format 
Wide format shows pickups to the right of spots, producing a wider screen. Narrow format 

shows pickups underneath spots, producing a narrower screen. These options are also 

available from the View menu or by pressing F6 or F7 respectively. 

In wide format, rows are coloured grey and white alternatively. In narrow format, spots are 

in green and pickups are in grey. 

Summary of Manoeuvres per Trip 
The program will generate some or all of the following types of manoeuvre depending on 

how you have set up your data. 

1. To one spot location and back to storage. Loaded cars are unloaded at their 

destination and vice versa. 

2. To one or more spot locations before returning. Load direction can be unspecified (x). 

If load direction is specified, loaded status will alternate, e.g. a car starting off loaded 

will be emptied at the first location, loaded at the second location etc. The car may be 

returned to storage in between. Locations can be paired such that a car will be sent 

empty to the first for ‘loading’ and then to the second for ‘unloading’ on the next trip. 

3. Randomly, to off-spots where the destination is still occupied (if this option is 

chosen). The car will be moved to its destination next trip. 

 
Clicking the Show Car Cards button will show the moves in a basic car card/waybill style for 

cutting out, six per A4 or Letter page. The car cards are colour-coded depending on whether 

the move is a spot or a pickup. The cards are taken directly from the switchlist, so the trip 

number is not car-specific, as it would be on a standard multi-cycle waybill. 

The car cards can also be printed via this screen. 

  
The switchlist and car cards will be printed pretty much as seen on-screen. For the switchlist, 

the user-selected column widths will be used. 

The Print Setup button can be used to choose printer, paper size etc., and landscape or 

portrait format, but the car cards should be printed on A4 or Letter paper in portrait format. 

If the switchlist is too wide for the selected page format, you will be given the option to 

cancel. 



 

 
This screen shows all possible combinations of cars, loads and locations allocated. Of course, 

not all of these will necessarily be used on a given run. The data can be sorted by any of the 

columns, ascending or descending, to facilitate checking that you have set up your data as 

desired. 

 
This button restores the default column widths if they have been changed manually. 

 
If you want to make a fresh start, or delete the sample data, this button will clear all data in 

the currently selected dataset. This is a pretty drastic thing to do so you are advised to make 

a backup copy beforehand of the data (.db3) files in the Switcher20 sub-folder of your 

Documents folder. 

If you have any queries on operating the program, or would like to suggest improvements, 

feel free to contact me at showerydan@live.com 
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